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K6600890

[POST-PROCEDURE 3]

— OUTLINE —

® Execute CUDG on P-DEV.

@ Specify recovery.

® Copy back

® Reset ORM Error Count on the P-DEV.
® Reset Threshold Counter

® SIM Complete

Copyright ©1995, Hitachi, Ltd.
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<Check the beginning of recovery>

Select [Yes] (CL) in response to “Do you restore the
physical device?”.

Please insert floppy disk and select [Yes] (CL).
Failure information of the physical device is written to
the floppy disk.

= Hardware Maintenance

0 Do you restore the physical device?

Yes

No

= Hardware Maintenance

Please insert dump FD and push [Yes].
if you don't have dump FD,please pushiNo].

IXes] I H01

<Spin up the Physical Drive>
“Spinning up the physical device...” is displayed.

Hardware Maintenance

Spinning up the physical device...

<DKU INLINE>

[In case of Isolation and Recovery Procedures for
Common SCSI Bus Error (TRBL05-30):]

Select [No] in responce to “Are you sure you want to
perform DKU INLINE for the physical device?”.

[Incase of PDEV replace only:]
“DKU INLINE is now running...” is displayed.

Notes: In case of RAID 0, go to REP04-25.

- Hardware Maintenance

Are you sure you want to perform DKU INLINE
for the physical device?

] (=]

Copyright ©1895,1996,1997, Hitachi, Ltd.
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<In case of RAID0>

(1) <Confirm of replace the PCB>
Display of “Did you replace the PCB?”.
In case of replaced the PCB, select (CL) [Yes].
In case of not replaced the PCB, select (CL) [No}.
- (Go to 4 on REP04-30.)

= Confirm Message

9 Did you replace the PCB?

(2) <Insert FD>

Select (CL) [OK] in response to “Please insert FD for drive A:”

after insert FD (Phase data only).

= D6 Message

Please insert FD for drive A:

0K

(3) <Input Product Number>
Select (CL) [OK] after input Product Number.

Product Number

L1

Please input Product Number :

OK

Notes: In case of invalid Product Number, select (CL) [Yes].

Return to (2).

(4) <Pull out the CONNASSY (JMP)>
Select (CL) [OK] in response to “Please pull out the
Jumper Pin. If OK| press return.” after pull out and
insert the CONNASSY (JMP).
Go to 4 on REP04-30

- Pull out Message

Please pull out the Jumper Pin. If OK, press

return,

Notes: In case of error in C1 Link Series (Refer to DIAGNOSIS SECTION), go to (5).

(5) <Replace to the former PCB>

Select (CL) [OK] in response to “Please replace to the
former PCB. If OK, press return.” after replaced the

unit.
Go to 4 on REP04-30

—— Replace Message

Please replace to the former PCB. If OK, press
return.

Copyright ©1997, Hitachi, Ltd.

| REV.0 ||Mar.1997l |

l [ | REP04-25




[In case of Isolation and Recovery Procedures for
Common SCSI Bus Error (TRBL05-30):]
Select [Noj (CL) in responce to “Are you sure you want

Hardware Maintenance

Are you sure you want to replace the micro
program?

to replace the micro program?”.
| Yes L No J

[Incase of PDEV replace only:]
‘When the revision of the DKU micro-program in the Microprogram Exchange
SVP hard disk is newer than that in the PDEV, the 0 The DKU microprogram Is old revision.

3 An exchange of the DKU microprogram will be
following message appears on the screen. etoried. 9
“The DKU microprogram is old revision. An exchange
of the DKU microprogram will be started.”
Select [OK] (CL). The message “Exchanging DKU — .

Kee00890-
4. <Replacement of the DKU micro-program>
|
I
|

TNicTo-program...” appears.

5. <Restore Physical Drive>
“Restoring the physical device...” is displayed.

Hardware Maintenance

Restoring the physical device...

6. <Check beginning of copyback>
Select [OK] (CL) in response to [Copy back?]. Hardware Mainlenance

Do you want to recover the data from spare disk

now?

[es | [ o |

Copyright ©1995,1996, Hitachi, Ltd.
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7. <Check end of copyback>
Select [OK] (CL) in response to
“Recovering the data from spare disk has started ™.

= Hardware Maintenance

Recovering the data fram spare disk has
started.

oK

BLANK

9. <Resetting ORM Error Counter>
(1) Select (DC) the [Information] icon in the ‘SVP’ window.

ﬁ

bratzrraation Status Diag
Fdcopy Install Onine

(2) Select (CL) [OK] in the “SVP’ dialog box.

Copyright (C) 1994,1985, Hitachi,Ltd.

OK

(3) Select (CL) the [Mode] menu in the ‘Information’
window and select (DR) [Modify]. Bie View

Copyright ©1995,1996, Hitachi, Ltd.
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(4) Select (CL) the [View] menu in the ‘Information’
window and select (DR) [Online Read Margin].
A pop-up menu will appear. Select (DR) [Over
Rate Display].

(5) In the ‘ORM Over Rate HDD# Display’ dialog box, select (CL)
the HDD for which an error count and thresholds are to be

reset from the ‘HDD Location’ list box. Select (CL) [Detail]. Bl
T

R2mM o800
=]

(6) In the ‘Over Rate Counter Display’ dialog box,
select (CL) [RESET].

(7) Select (CL) [OK] in the “Threshold Counter Reset’
dialog box.

(8) Select (CL) [Close] in the ‘Over Rate Counter Display’ dialog box.

(9) Select (CL) [Close] in the “ORM Over Rate HDD# Display’ dialog box.

(10) Close the ‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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10. <Reset Threshold Counter>
See SVP02-440.

11. <S]M Complete>
See SVP02-510.

12.
Close ‘HDU-xxx’ window.
Close ‘Hardware Maintenance’ window.
Close ‘Maintenance Online’ window.

Copyright ©1996,1997, Hitachi, Ltd.
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BLANK SHEET
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[POST-PROCEDURE b]

— OUTLINE —

@ Execute CUDG on P-DEV.
@ Specify recovery.
® Correction copy

® Reset ORM Error Count on the P-DEV.

® Reset Threshole Counter
©® SIM Complete

Copyright ©1995, Hitachi, Ltd.
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1. <Check the beginning of recovery>
Select [Yes] (CL) in response to “Do you want to
restore the physical device now?”,

Please insert floppy disk and select [Yes] (CL).
Failure information of the physical device is written to
the floppy disk.

= Hardware Maintenance

Do you want te restore the physical device
now?

Lyes | | Mo |

- Hardware Maintenance

Please insert dump FD and push [Yes].
i you don't have dump FD,please pushiNo].

Lyes | [ %o ]

2. <Spin up the Physical Drive>
“Spinning up the physical device” is displayed.

Hardware Maintenance

Spinning up the physical device...

3. <DKUINLINE>
[In case of Isolation and Recovery Procedures for
Common SCSI Bus Error (TRBL05-30):]
Select [No] in responce to “Are you sure you want to
perform DKU INLINE for the physical device?”.

[Incase of PDEYV replace only:]
“DKU INLINE is now running.” is displayed.

Notes: In case of RAID 0, go to REP04-55.

- Hardware Maintenance

Are you sure you want to perforrm DKU INLINE
for the physical device?

Lxes | [ Mo |

Hardware Maintenance

DKU INLINE is now running...

Copyright ©1995,1996,1997, Hitachi, Ltd.
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<In case of RAID0>

(1) <Confirm of replace the PCB>
Display of “Did you replace the PCB?”.
In case of replaced the PCB, select (CL) [Yes).
In case of not replaced the PCB, select (CL) [No].
(Go to 4 on REP04-50.)

— Confirm Message

0 Did you replace the PCB?

Yes No

(2) <Insert FD>
Select (CL) [OK] in response to “Please insert FD for drive A:” = D6 Message
after insert FD (Phase data only).

Please insert FD for drive A:

OK

(3) <Input Product Number>
Select (CL) [OK] after input Product Number. Product Number

Please input Product Number : l_—_]

OK

Notes: In case of invalid Product Number, select (CL) [Yes].
Return to (2).

(4) <Pull out the CONNASSY (JMP)>

Select (CL) [OK] in response to “Please pull out the
Jumper Pin. If OK, press return.” after pull out and Please pull out the Jumper Pin. if OK, press

insert the CONNASSY (IMP). return.

Go to 4 on REP04-50

Notes: In case of error in C1 Link Series (Refer to DIAGNOSIS SECTION), go to (5).

(5) <Replace to the former PCB>
Select (CL) [OK] in response to “Please replace to the Replace Message
former PCB. If OK, Ppress Teturn.” after replaced the Piease replace to the former PCB. If OK, press
unit. return,

Go to 4 on REP04-50 )

Copyright ©1997, Hitachi, Ltd.
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4. <Restore the Physical Device>

“Resoring the physical devic.” i displayed

Restoring the physical device...

BLANK

6. <Checking the Drive Status>
“Checking the physical device status...” is displayed.
Device is still blocked.

Hardware Maintenance

Checking the physical device status...

7. <Correction copy>
Select [Yes] (CL) in response to “Do you want to do a
correction copy from disk drives now?”.

Hardware Maintenance

Do you want to do a correction copy from disk
drives now?

[es | [ 8 |

8. <Check the beginning of Correction copy>
Select {OK] (CL) in response to “Correction copy from
disk drives is started.”.

= Hardware Maintenance .

O Correction copy from disk drives is started.

Copyright ©1995,1996, Hitachi, Ltd.
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Blank Sheet

Copyright ©1995, Hitachi, Ltd.
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BLANK

10. <Resetting ORM Error Counter>
(1) Select (DC) the [Information] icon in the ‘SVP’ window.

- _T—_ﬁ -
Status Diag
install Oniine

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C) 1994,1995, Hitachi,Ltd.

OK

(3) Select (CL) the [Mode] menu in the ‘Information’
window and select (DR) [Modify]. Hic View

View

Copyright ©1995,1996, Hitachi, Ltd.

| REV.4 [mar.1995 | Apr.1985 | sun.1985 | oct.1995 | May. 1096

| REPO04-71




K6600890

(4) Select (CL) the [View] menu in the [Information]
window and select (DR) [Online Read Margin].

A pop-up menu will appear.. Select (DR) [Over
Rate Display].

Infarmation

Toreehold Valoe Msnager )

Online Head Matgin

Maininanze Histeny..,

(5) In the [ORM Over Rate HDD# Display] dialog box, select (CL)
the HDD for which an error count and thresholds are to be
reset from the [HDD Location] list box. Select (CL) [Detail].

(6) In the [Over Rate Counter Display] dialog box, -
Se]ect (CL) [RESm_ - Over Rate Counter Display

| Ervor Comt / Thesshold Valon | L0000 <]

(7) Select (CL) [OK] in the [Threshold Counter Reset]
Threshold Counter Reset

Are you sure to reset Threshold Counter of all

Copyright ©1995, Hitachi, Ltd.
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(8) Select (CL) [Close] in the ‘Over Rate Counter Display” dialog box.
(9) Select (CL) [Close] in the ‘ORM Over Rate HDD# Display’ dialog box.

(10) Close the ‘Information’ window.

10. <Reset Threshold Counter>
See SVP02-440.

11. <SM Complete>
See SVP02-510.

12.
Close ‘HDU-xxx" window.
Close ‘Hardware Maintenance’ window.
Close ‘Maintenance Online’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[POST-PROCEDURE c]

— Projected —

— OUTLINE —

® Perform L-DEV formatting on P-DEV.
@ Reset ORM Error Count on P-DEVSs.
® Recover with backup data.

@ Reset Threshold Counter

® SIM Complete

Copyright ©1995, Hitachi, Ltd.
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1. <Check the beginning of recovery>

Select[Yes] (CL)in esponse to “Do you restore the

physical device?”.

9 Do you restore the physical device?

Yes No

Please insert floppy disk and select [Yes] (CL)

Failure information of the physical device is written to Please Insert dump FD and push [Yes].
the floppy disk. if you don't have dump FD,please push[No].

Lxes | [ o |

2. <Spin up the Physical Drive>
“Spinning up the physical device..” s displayed.

Spinning up the physical device...

3. <DKUINLINE>

[In case of Isolation and Recovery Procedure for
Common SCSI Bus Error (TRBL05-30)] Are you sure you want to perform DKU INLINE
Select [No] (CL) in response to “Are you sure you want for the physical device?
to perform DKU INLINE for the physical device?”.

P o s ] [0 ]
[In case of PDEV replace only:]

“DKU INLINE is now running...” is displayed.

Notes: In case of RAID 0, go to REP04-98.

Copyright ©1995,1996,1997, Hitachi, Ltd.
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4. <Replacement of the DKU micro-program>
[In case of Isolation and Recovery Procedures for
Common SCSI Bus Error (TRBL05-30):]
Select [No] (CL) in responce to “Are you sure you want
to replace the micro program?”,

[In case of PDEV replace only:]

When the revision of the DKU micro-program in the
SVP harg disk is newer than that in the PDEV, the
following message appears on the screen.

“The DKU microprogram is old revision. An exchange
of the DKU microprogram will be started.”

Select [OK] (CL). The message “Exchanging DKU
micro-program...” appears.

Hardware Maintenance

program?

Micr(;_;;;bt-;ram Exchangé

started.

Are you sure you want to replace the micro

The DKU microprogram is old revision.
An exchange of the DKU microprogram will be

Microprogram Exchange

5. <Restore Physical Drive>
“Restoring the physical device...” is displayed.

Hardware Maintenance

6. <Referring the Drive Status>
“Referring the physical device status...” is displayed.

Hardware Maintenance

Refemting the physical device status...

Copyright ©1995,1996, Hitachi, Ltd.
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7. <Correction Copy disable message>
Select [OK] (CL) in response to “There is no Logical = Hardware Maintenance

ce which can be restored.”. There is na Logical Device which can be

restored.

OK

8. <Select [Logical Device Maintenance...]>
Select [Logical Device Maintenance...] from E—
[Maintenance] on ‘Maintenance Online’ (DR).
Before you perform following steps, be sure to call
T.S.C.

Data housed in Logical Device will be lost due to
formatting Logical Device.

9. <Logical Device Maintenance List>

Select [Format...] (CL). {77 77 "Logical Device Maintenance List
LOEV Parity Group Status
ORAMAL)
S
% 0 NORMAL} o]
® o (NORMAL}
% o INORMALY

10. <Format Logical Device>

Select the Target [Parity group specified by logical device] from § Format Logical Device
‘Format Logical Device’ (CL) and select [OK] (CL).

Taget -
O Specified logical device
Note: Execute Format Logical Device after you confirm the @® !Pariky group specified by logical device!

target Logical Device is blocked.
Target LDEV ID: 00, 01, 02, 63, 04, 05, 06, 07

[ ok | | cance

Copyright ©1995,1996, Hitachi, Ltd.
- l REV3 HApr.1995|Jun.19951Dec.1995|May.1996| | | REP04'92
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11. <Caution message for DATA lost>
Select [No] (CL) in response to “Data housed in the = Hardware Maintenance [
specified logical device will be lost due to this

Data housed in the specified logical device will
operation. Do you stop this process?”. 0

be lost due to this operation. Do you stop this
process?

Lyes | | Mo |

12. <Check Formatting the logical Device>
“Formatting the logical device...” is displayed.

13. <Check the end of Format Logical Device>
Select [OK] (CL) in response to “Formatting the logical =

device is completed.”.
o Formatting the logical device is completed.

14.
BLANK

Copyright ©1995,1996, Hitachi, Ltd.
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15. <Resetting ORM Error Counter>
(1) Select (DC) the [Information] icon in the ‘SVP’ window.

ﬁ

Irharrnation Status Diag
Fdcopy Install Onfine

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

Copyright (C) 1994,1995, Hitachi,Ltd.

oK

(3) Select (CL) the [Mode] menu in the “Information’.
window and select (DR) [Modify]. e View

e

(4) Select (CL) the [View] menu in the ‘Information’

window and select (DR) [Online Read Margin]. e - £
A pop-up menu will appear. Select (DR) [Over = —

Copyright ©1995,1996, Hitachi, Ltd.
[ REV2 [May.1995 Jun.1965 | May. 1996 | | I | REP04-94
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(5) In the ‘ORM Over Rate HDD# Display’ dialog box, select (CL)
the HDD for which an error count and thresholds are to be

reset from the “‘HDD Location’ list box. Select (CL) [Detail]. :
eI
R20 Ban.0
[Dwesiid]
- | Closs |

(6) In the ‘Over Rate Counter Display’ dialog box,
select (CL) [RESET).

[ Esrws Comnt 7 Theashold Value |

(7) Select (CL) [OK] in the ‘Threshold Counter Reset’
dialog box. = ~ Threshold Counter Reset

Are you sure to reset Threshold Counter of all
ID?

| ok | |cancel]

(8) Select (CL) [Close] in the ‘Over Rate Counter Display’ dialog box.
(9) Select (CL) [Close] in the ‘ORM Over Rate HDD# Display’ dialog box.

(10) Close the ‘Information’ window.

Copyright @1995,1996, Hitachi, Ltd.
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K6600890-

16. <Reset Threshold Counter>
See SVP02-440.

17. <SIM Complete>
See SVP02-510.

18.
Close ‘Logical Device Maintenance List” window.
Close ‘Maintenance Online’ window.

19. <Recover data>
Ask the customer for recovering data with backup data.

Copyright ©1996, Hitachi, Ltd.
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<In case of RAID0O>

(1) <Confirm of replace the PCB>
Display of “Did you replace the PCB?”.
In case of replaced the PCB, select (CL) [Yes].
In case of not replaced the PCB, select (CL) [No].
(Go to 4 on REP04-90.)

= Confirm Message

g Did you replace the PCB?

No

(2) <lInsert FD>
Select (CL) {OK] in response to “Please insert FD for drive A:” = D6 Message
after insert FD (Phase data only).

Please insert FD for drive A:

OK

(3) <Input Product Number>
Select (CL) [OK] after input Product Number.

Please input Product Number @ |:

Notes: In case of invalid Product Number, select (CL) [Yes].
Return to (2).

(4) <Pull out the CONNASSY (JMP)>

Select (CL) [OK] in response to “Please pull out the
Jumper Pin. If OK, press return.” after pull out and Piease pull out the Jumper Pin. if OK, press
insert the CONNASSY (JMP). return.

Go to 4 on REP04-90

Notes: In case of error in C1 Link Series (Refer to DIAGNOSIS SECTION), go to (5).

(5) <Replace to the former PCB>

Select (CL) [OK] in response to “Please replace to the
former PCB. If OK, press return.” after replaced the Please replace to the former PCB. lf OK, press
unit, return,

Go to 4 on REP04-90 '

Copyright ©1997, Hitachi, Ltd.
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[POST-PROCEDURE d]

— OUTLINE —

@ Execute CUDG on P-DEV.

@ Specify recovery.

® Reset ORM Error Count on the P-DEV.
@ Reset Threshold Counter

® SiIM Compiete

Copyright ©1995, Hitachi, Ltd.
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<Check the beginning of recovery>
Select [Yes] (CL) in response to
“Do you restore the Physical Drive?”.

Please insert floppy disk and select [Yes] (CL).
Failure information of the physical device is written to
the floppy disk.

= HARDWARE MAINTENANCE

0 Do you restore the Physical Drive ?

Yes No

- Hardware Maintenance

Please insert dump FD and push [Yes].
if you don't have dump FD,please push[No].

|Ies | Lﬂo ]

<Check the spin up process>
“Spinning up the physical device..:” is displayed.

Hardware Maintenance

Spinning up the physical device...

<Check the INLINE process™>

[In case of Isolation and Recovery Procedure for
Common SCSI Bus Error (TRBL05-30):]

Select [No] (CL) in response to “Are you sure you want
to perform DKU INLINE for the physical device?”.

[In case of PDEV replace only:]
“DKU INLINE is now running...” is displayed.

Notes: In case of RAID 0, go to REP04-117.

- Hardware Maintenance

Are you sure you want to perform DKU INLINE
for the physical device?

Les | [ Mo |

Hardware Maintenance

DKU INLINE is now running...

Copyright ©1995,1996,1997, Hitachi, Ltd.
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4. <Replacement of the DKU micro-program>
[In case of Isolation and Recovery Procedures for

Hardware Maintenance

Common SCSI Bus Error (TRBLO5-30):] 9 Are you sure you want to replace the micro
Select [No] (CL) in responce to “Are you sure you want program?
to replace the micro program?”.

Lyes | | no |

[In case of PDEV replace only:]

When the revision of the DKU micro-program in the ~ § Microprogram Exchange

SVP hard disk is newer than that in the PDEV, the The DKU microprogram Is old revision.
following message appears on the screen. 0 2; mange of the DKU microprogram will be
“The DKU microprogram is old revision. An exchange

of the DKU microprogram will be started.”

Select [OK] (CL). The message “Exchanging DKU — |

micro-program...” appears.

i Microprogram Exchange j

Ezchanging DKU micro-program....

5. <Check the Restore process>
“Restoring the Physical Drive.” is displayed. Hardware Maintenance

Refering the Physical Drive status ._.

6. <Check the end of P-DEV recovery>
Select [OK] in response to
“Restoring the Physical Drive has completed.”.

BLANK

Copyright ©1995,1896, Hitachi, Ltd.
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8. <Resetting ORM Error Counter>
(1) Select (DC) the [Information] icon in the ‘SVP’ window.

|
8 O

EEEEE Sew  Dig

1
9

iC

Instal

]

(2) Select (CL) [OK] in the ‘SVP’ dialog box.

(3) Select (CL) the [Mode] menu in the ‘Information’
window and select (DR) [Modify].

Information

(4) Select (CL) the [View] menu in the ‘Information’

window and select (DR) [Online Read Margin]. W
A pop-up menu will appear. Select (DR) [Over L=
Rate Display].

Copyright ©1995,1996, Hitachi, Ltd.
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(5) In the ‘ORM Over Rate HDD# Display’ dialog box, select (CL)
the HDD for which an error count and thresholds are to be
reset from the “HDD Location’ list box. Select (CL) [Detail].

(6) In the ‘Over Rate Counter Display” dialog box,
select (CL) [Reset].

| Esvor Count 7 Thoashold Vales | E

(7) Select (CL) [OK] in the “Threshold Counter Reset’
dialog box. ~ Threshold Counter Reset

Are you sure to reset Threshold Counter of all
ID?

| ok | |cancer]

(8) Select (CL) [Close] in the ‘Over Rate Counter Display’ dialog box.
(9) Select (CL) [Close] in the ‘ORM Over Rate HDD# Display’ dialog box.

(10) Close the ‘Information’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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9. <Reset Threshold Counter>
See SVP02-440.

10. <SIM Complete>
See SVP02-510.

11.
Close ‘HDU-xxx’ window.
Close ‘Hardware Maintenance’ window.
Close ‘Maintenance Online’ window.

Copyright ©1996, Hitachi, Ltd.
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<In case of RAID0>

)

<Confirm of replace the PCB>

Display of “Did you replace the PCB?”.

In case of replaced the PCB, select (CL) [Yes].

In case of not replaced the PCB, select (CL) [No].
(Go to 4 on REP04-111.)

= Confirm Message

Q Did you replace the PCB?

(2) <Insert FD>
Select (CL) [OK] in response to “Please insert FD for drive A:”
after insert FD (Phase data only).
Please insert FD for drive A:
0K
(3) <Input Product Number>

Select (CL) [OK] after input Product Number.

Product Number

[ ]

Piease input Product Number :

OK

Notes: In case of invalid Product Number, select (CL) [Yes].

Return to (2).

G

<Pull out the CONNASSY (JMP)>

Select (CL) [OK] in response to “Please pull out the
Jumper Pin. If OK, press return.” after pull out and
insert the CONNASSY (JMP).

Go to 4 on REP04-111

-— Pull out Message

Please pull out the Jumper Pin. H OK, press

return.

Notes: In case of error in C1 Link Series (Refer to DIAGNOSIS SECTION), go to (5).

&)

<Replace to the former PCB>

Select (CL) [OK] in response to “Please replace to the
former PCB. If OK, press return.” after replaced the
unit.

Go to 4 on REP04-111

- Replace Message

Please replace to the former PCB. If OK, press
return.

Copyright ©1997, Hitachi, Ltd.
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[POST-PROCEDURE ¢]

— OUTLINE —

® Execute CUDG on cache.
@© Specify recovery.
® SIM Complete

Copyright ©1995, Hitachi, Ltd.
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1. <Check the beginning of cache/SM recovery>
Select [Yes] (CL) in response to:
* For CACHE (with SM)
“Do you want to restore the Shared Memory and Cache
Memory PCB now?”
* For CACHE [Go to step 3]
“Do you want to restore the Cache Memory PCB now?”
* For CPM, CPS, CACHE Terminator

“Do you want to restore the Shared Memory PCB now?”

After the recovery processing, delete the SIM LOG
(see SVP section).

Hardware Maintenance

Do you want to restore the Shared Memory and
Cache Memory PCB now?

=] (]

2. <Restoring the Shared Memory>
“Restoring the Shared Memory PCB...” is displayed.

* For CPM, CPS

[Go to step 4]

Hardware Maintenance

Restoring the Shared Memory PCB...

3. <Restoring the Cache Memory>
“Restoring the Cache Memory PCB...” is displayed.

Hardware Maintenance

Restoring the Cache Memory PCB...

Copyright ©1995,1996, Hitachi, Ltd.
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4. <Check the end of Cache/Shared Memory recovery>
Select [OK] (CL) in response to: - Hardware Maintenance }
* For CACHE (with SM) Restoring thc.Sharcd Memory and Cache
“Re“?mg the Shared Memory and Cache Memory gli:'socry dxpfi :uﬁl:;g::: ds':atus with STATUS.
PCB is completed. Please check subsystem status with
STATUS.”
* For CACHE
“Restoring the Cache Memory PCB is completed.
Please check subsystem status with STATUS.”
* For CPM,CPS
“Restoring the Shared Memory PCB is completed
Please check subsystem status with STATUS.”

5. <SIM Complete>
See SVP02-510.

Close ‘MainPlatter Maintenance’ window.
Close ‘Hardware Maintenance’ window.
Close ‘Maintenance Online’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[POST-PROCEDURE f]

— OUTLINE —

@ Specify recovery for CHA/DKA.
@ Path online (for CHA)
® SIM Complete

Copyright ©19895, Hitachi, Ltd.
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1. <Check the beginning of CHA/DKA recovery>

. S nancr e
Select [YES] (CL) in response to: T
= ‘Lo Phanes Maidcanace Lapag
* For CHA Mo S - e
© CacHE:- O oxa1
[Do you want to restore the CHA now?] a1 Coears  muemy 1
O auzr e
GO TO STEP3 Oeuz
QOorazp
* For DKA Oomaaw
O oxaem
[Do you want to restore the DKA now?] ©oraz
GO TO STEP2
[DKU PATH INLINE] displayed e T
= s L
(for DKA) ; =
Name p=T Y
!oncuz-zr DEU PATH IHLINE o autwe rummeny. EWETY |
l © cacHE-28 EWPTY |
O cHa (¥
ooz Ao |
| © braze eORMAL |
: O orazn EMPTY | O CHAE MNORMAL )
| O oxazMm MY | O CACMEAID  [EMPTY |
O ora2L NORMAL ] O cacHEC NORMAL |

3. <Micro-program down loading>

[Micro-program Exchange] is displayed.
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4. <Check the CHA/DKA Tecovery processing>

The fllowing message i displayec:

* For CHA i A
“Restoring the CHA..” Restoring the CHA...

* For DKA Hardware Maintenance

Restoring the DKA...

“Restoring the DKA...”

“SCSI BUS nializaton proces i onning..

SCSI BUS initialization process is running...

“Restoring the DKA...” Hardware Maintenance

Restoring the DKA...

5. <Check the end of CHA/DKA recovery>

Select [OK] (CL) in response to : Hardware Maintenance

* For CHA Restoring the DKA is completed.

“Restoring the CHA is completed. Please check Please check subsystem status with STATUS.
subsystem status with STATUS.”

* For DKA

“Restoring the DKA is completed. Please check

subsystem status with STATUS.”

Copyright ©1995,1996, Hitachi, Ltd.
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6. <Path on-line when CHA is replaced>
Whenever a CHA is replaced, set the path
(from the host) on the replaced Host Adapter
PCB to ONLINE.

7. <SIM Complete>
See SVP02-510.
In case of Multiplatform, after a CHA is replaced, when channel path on the replaced Host Adapter PCB is varied
ONLINE, SSB F/M=9f and EC=4328 is logged sometimes. It is no problem because the SSB just shows OPEN
Volume was accessed by Host I/O.

Close ‘MainPlatter Maintenance’ window.
Close ‘Hardware Maintenance’ window.
Close ‘Maintenance Online’ window.

Copyright ©1995,1997, Hitachi, Ltd.
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[POST-PROCEDURE (]

— OUTLINE —

® Correction copy processing
@ Correction copy termination

Copyright ©1995, Hitachi, Ltd.
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1. <Check the comrection copy processing>
[Correction copy in progress] is displayed.

2. <Check the end of correction copy>
Select [OK] (CL) in response to
[End of correction copy].

Copyright ©1995, Hitachi, Ltd.
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[POST-PROCEDURE h]

— OUTLINE —

® Specify recovery of DKA for SCSI BFR.
@ SIM Complete

Copyright ©1995, Hitachi, Ltd.
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1.

<Confirm SCSI buffer replace>

Select [OK] (CL) in response to “Please replace the = Hardware Maintenance

SCSI Buffer. If OK, press return.”. . 0 Please replace the SCSI Buffer. If OK, press
return.

2.

<Check the beginning of DKA recovery>

Select [YES] (CL) in response to “Do you want to
restore the DKA now?”. _

Hardware Maintenance

9 Do you want to réstore the DKA now?

3.

<DKA PATH INLINE>
“DKA PATH INLINE is now running...” is displayed.

Hardware Maintenance

DKU PATH INLINE is now running...

Copyright ©1995, Hitachi, Ltd.
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4. <Check DKA recovery processing>
“Restoring the DKA...” is displayed.

Hardware Maintenance

Bestoring the DKA...

5. <SCSIBUS initialization process>
“SCSI BUS initialization process is running...” is
displayed.

Hardware Maintenance

SCSI1 BUS initialization process is running...

6. <Check the end of CHA / DKA recovery>

Select [OK] (CL) in response to “Restoring the DKA is Hardware Maintenance

completed. Please check subsystem status with

Restoring the DKA is completed.

STATUS.”. Please check subsystem status with STATUS.

Copyright ©1995,1996, Hitachi, Ltd.
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7. <SIM Complete>
See SVP02-510.

Close ‘MainPlatter Maintenance’ window.
Close ‘Hardware Maintenance’ window.
Close ‘Maintenance Online’ window.

Copyright ©1985,1996, Hitachi, Ltd.

| REv.4 [ Apr.1995 | May. 1995 Jun.1995 | Nov. 105 | May.1096 | REP04-202




K6600890-

[POST-PROCEDURE i]

— OUTLINE —

® Specify recovery for CHA/DKA.
@ Path online (for CHA)
® SIM Complete

Copyright ©1995, Hitachi, Ltd.
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1. <Check the beginning of CHA/DKA recovery>
Select [Yes] (CL) in response to:
* For CHA
“Do you want to restore the CHA now?”
Go to step 4.
* For DKA
“Do you want to restore the DKA now?”
Go to step 2.

== Hardware Maintenance

g De you want to restore the DKA now?

Yes Neo

2. <Check beginning of Path INLINE> (Only DK A)
“Are you sure you want to perform DKU PATH INLINE
for the physical device?” is displayed.
* In case of SCSI BUS trouble:
Select [No] (CL) in response to the message.
Go to Step 4.
* In case of no trouble about SCSI BUS:
Select [Yes] (CL) in response to the message.
Go to step 3.

- Hardware Maintenance

- Are you sure you want to perform DKU PATH
INLINE for the physical device?

[T] (]

“DKU PATH INLINE” is displayed
(for DKA)

Hardware Maintenance

DKU PATH INLINE is now running...

Copyright ©1995,1996, Hitachi, Ltd.
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<Check the CHA/DKA recovery processing>
The following message is displayed:

* For CHA

“Restoring the CHA...”

* For DKA

“Restoring the DKA...”

“Spinning up the physical device...”

“Restoring the DKA...”

Hardware Maintenance

Restoring the CHA. ..

Hardware Maintenance

Restoring the DKA...

Hardware Maintenance

Spinning up the physical device...

Hardware Maintenance

Restoring the DKA__.

<Check the end of CHA/DKA recovery>

Select [OK] (CL) in response 1o :

* For CHA

“Restoring the CHA is completed. Please check
subsystem status with STATUS.”

* For DKA

“Restoring the DKA is completed. Please check
subsystem status with STATUS.”

-— Hardware Maintenance

Restoring the DKA is completed.
Please check subsystem status with STATUS.

Copyright ©1995,1996, Hitachi, Ltd.
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6. <Path on-line when CHA is replaced>
Whenever a CHA is replaced, set the path
(from the host) on the replaced Host Adapter
PCB to ONLINE.

7. <SIM Complete>
See SVP02-510.

Close ‘MainPlatter Maintenance’ window.
Close ‘Hardware Maintenance’ window.
Close ‘“Maintenance Online’ window.

Copyright ©1995,1996, Hitachi, Ltd.
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[POST-PROCEDURE t1]

— OUTLINE —

® Specify end of special part replacement.
@ Reinstali related parts.

® Start environment monitor.

@ SIM Complete

Copyright ©1995, Hitachi, Ltd.
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[1] Start of POST-PROCEDURE

1. <Check replacement of special part>

Select [OK] (CL) in response to “Please replace the "X3OXXX." After replacement, press OK.”
Valid “XXXXX” values are listed below.

* System panel Go to [16] (REP04-351)

* PCI CONN ——— Go to [5] (REP04-270) Please replace the ''System panel."” After
* RCU CONN ---—— Go to [6] (REP04-280) replacement, press OK.

« EPO SW —-———— Go to [7] (REP04-290) i

« RS CONN ————— Go to [13] (REP04-350) ok | [Cence |

* OP panel 1/2 ——- Go to [2] (REP04-240)

Select [OK] (CL) in response to “Please switch "XXXXX" to "DISABLE," and replace it. After replacement, switch

it to "ENABLE" and press OK.”

Valid “XX30(X values are listed below.
* CE panel —————— Go to [3] (REP04-250) Please switch "PWRCTL-1" to "DISABLE." and

* PWRCTL 1/2 ———- Go to [4] (REP04-260) 0 replace it. After replacement, switch it to

“ENABLE™ and press OK.

l OK | [Canceﬂ

Select [OK] (CL) in response to “Please replace the target
PCBs, when replacement completed press OK.”.
-LTMPCB

M Othes |

Please replace the target PCBs, when
Go to [10] (REP04-315) replacement completed press OK.

oK

= OUTLET BOX --— Go to [8] (REP04-300)

Copyright ©1995,1996, Hitachi, Ltd.
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¢ SVP ———————— Go 10 [9] (REP04-301)

Select [OK] (CL) in response to “After turning "SSVP SSVP Hardware Replace
ENABLE" switch to "DISABLE", th lace SSVP.”.

- Wi en rep After turning "SSVP ENABLE™ switch to
* SSVP ————— Go o0 [12] (REP04-330) “DISABLE™, then replace SSVP.

Copyright ©1995,1996, Hitachi, Lid.
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[2] OP panel

1.

If all channel types are SCSI, execute only <LED TEST>.

Select [OK] (CL) in response to “Please up IND TEST
switch, and check LED on. Then press OK.”.

If there are no parallel channels, go to [13] (REP04-
350).

<Diagnostic of SW. on OP panel>
Select [OK] (CL) in response to “Please set all channel :_ﬂm_
switches to DISABLE, and FORCE OFF switch to Please set all channel switches to DISABLE. and
NORMAL. Then press OK.”. FORCE OFF switch to NORMAL. Then press OK.
Select [RENEW] (CL) in response to “Please check all channel
switches, and FORCE OFF switch. After setting a test pattern, press T = TYIN
RENEW” -
If all tests are done normally, select [OK] (CL). b H NONE
Note) You can’t test the channel which displayed “SCSI” at STATUS i : NORE

Colu.nm. FORCE OFFLINE : NDRMAL

(_Rewew | [ ox ] [Ceawcer |
TEST PATTERN
PATTERN# CHL# FORCE
A B C D E F G H OFF

1 @] X x X x x x % x

2 X O x x x X x X X

3 X X @] x x x x X T ox

4 x x x @] x X x X X

5 X x X X O x x x x

6 X x X x X O x x x

7 X X x x x x O X x

8 X x x x x x x O X

9 x X X X X X x X @]

O :ENABLE (FORCE OFF switch. : OFF)
x : DISABLE (FORCE OFF switch. : NORMAL)
<LED TEST>

Please up IND TEST switch, and check LED on.
Then press OK.

(o] [coer]

Copyright ©1995,1997, Hitachi, Ltd.
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2. <Display CH SW status>

Check whether the CH switch settings are the same as

those on the replaced OP panel. And select [OK] (CL). o e
¢ ENABLE
D ENABLE
STATUS: € NOKE
ENABLE : Channel is enable (parallel channel) i NOME
DISABLE : Channel is disable(parallel channel) FORCE OFFLINE :  NORMAL
SERIAL : Serial channel QR " S 10 poskin show shere. Then press
SCSI : SCSI channel

BLOCKADE : Connected CHP is blocked up.
NONE : Channel is not installed.
FORCE OFFLINE
OFFLINE : FORCE OFFLINE
NORMAL : NOT FORCE OFFLINE

3. <Read channel mode>
“Reading channel path mode from CHA...” is displayed.
If all switches are set correctly, go to 6.

OTHERS

Reading channel path mode from CHA...

If some switches are illegal, go to 4.

4. <Channel switch incorrect>

Please set switches correctly, and select [OK] (CL). l Chisinel Palh Stalus

CHLS STATUS
A ENABLE
B EMNABLE
c ENABLE
D ENABLE
E NONE
F NONE
& NONE
H NONE

FORCE OFFUNE : NORMAL

Switch position of "OP panct-1 PCB™ iz invabd.
Set switches to position shown above. Then press OK

OK|

5. <Read channel mode>
“Reading channel path mode from CHA...” is displayed.
If all switches are set correctly, go to 6.
If some switches are illegal, go to 4.
If step 4 is performed twice, go to 8.

OTHERS

Reading channel path mode from CHA...

Copyright ©1995,1996, Hitachi, Ltd.
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6. <Set channel switches to REMOTE>

Set channel switches to REMOTE that has been B mepace ||

REMOTE position before replacement. Picase sct channel switches to REMOTE that
Refer to memorandum is 2 of PRE-PROCEDURE T1 2} | €D Then prese o | Position before replacement
(REP02-420).

7. <change CHP mode>
“Changing channel path control from CHA to panel...” is
displayed.
Go to [13] (REP04-350).

Changing channel path control from CHA to
panel...

8. <error status>

If step 4 is performed twice, the error message is = wmeptacE ]|

displayed as shown on the right. ® After checking switch of "OP panel-2* three

Select [OK] (CL), go to [14] (REP04-350). :Ll'::!:ghhe:;;?;.stalus is not chang‘ed. fleasc

Copyright ©1895,1997, Hitachi, Ltd.
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[3] CE panel

1.

<Set REMOTE/LOCAL>

Set REMOTE/LOCAL switch, in response to the
message “Please set "REMOTE/LOCAL" switch of "CE
panel""XXXXX". Then press OK.”.

“XXXXX represents “REMOTE” or “LOCAL”.

After confirming that switch set, select [OK] (CL).

Go to [11] (REP04-320).

Please set "REMOTE/LOCAL" switch of “CE
panel' "LOCAL" Then press OK.

Copyright ®1995, 1997, Hitachi, Ltd.
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[4] PWRCTL 12

1

<Enable DKUMN>
Enable DKUMN in response to “Please switch

"XXXXX" of all DKU to "ENABLE.” Then press OK.”.
After confirming DKUMN is enabled, select [OK] (CL).

XXX
* For PWRCTL-1:

[Power on DKUMN on front side of DKU]
* For PWRCTL-2:

[Power on DKUMN on rear side of DKU]

T

Please switch "DKUMN-F" of all DKU to
"ENABLE." Then press OK.

<Check environment monitor start processing>
“Processing to enable the environment check...” is
displayed.

Wait about 30 seconds.

Processing to enable the environment
check...

<Check environment monitor read>
“Reading configuration...” is displayed.

“Reading the environment monitor...” is displayed.

Go to [13] (REP04-350).

OTHERS

OTHERS

Reading configuration...

Reading the envitonment monitor...
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[5] PCI CONN

1. <Reset CE panel SW>
Reset REMOTE/LOCAL SW to original value in

e REPLACE

response to “Please return REMOTE/LOCAL Sw, on 0 Please return REMOTE/LOCAL Sw, on “CE
"CE panel,” as before. Then press OK.” pancl” as before. Then press OK.

(see HARDWARE T6) (REP03-580). '

After checking SW setting, select [OK] (CL).

Go to [13] (REP04-350). n
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[6] RCU CONN

1. <Change CHP mode>

“Changing channel path control from CHA to panel...” is OTHERS K : 3
displayed.

Changing channel path contiol from CHA to
panel..

2. “The replacement of "RCU CONN" is done. And the °

OP pancls are restored (only parallel channcls).” is ﬁ
displayed. The replacement of *"RCU CONN™ is done. And

Select [OK] (CL). 0 the OP panels are restored (only paraliel

channels].

Go to [15] (REP04-350).
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[7] EPO SW

1.

“Reading the environment monitor...” is displayed.

Reading the environment monitor...

2. <Check connection>
If EPO SW is not connected with PWRCTL-2, connect :_m
them and select [OK] (CL). Go to 1 again. "EPO SW" is not connected with PWRCTL-2.
Piease check connection. Then press OK.
.-
<Check EPO SW status>
If EPO SW is not active, go to [11] (REP04-320).
If EPO SW is pulled (active), set correctly and select “EPO SW"is active. Please set "EPO SW* off.
[OK] (CL). Goto 1 again. Then press OK.
If either message displayed three times, go to 4. .
3. <PWRCTL's are not same>
When checking EPO SW status, information of
PWRCTL-1 and 2 are not same, select [OK]. @ Information of PWRCTL-1 and 2 are not same.
GO to [14] (REPO4'350). Please check "PWRCTL PCB."
4. <Checking connection, and EPO SW three times

and status is not changed.>

If vou repeat from step 2 three times, the error
message is displayed. Select [OK] (CL).
Go 1o [14] (REP04-350).

@ After checking "EPO SW* three times, the error

status is not changed. "PWRCTL PCB" may
have problem.
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[8] OUTLET BOX

1. Power on SVP.

2. Wait a few minutes.
Message “Loading SVP program” will be extinguished.
Go to [15] (REP04-350).

Copyright ©1995,1996, Hitachi, Ltd.
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[9] SVP

If Setup Installer floppy has version 01-00-xx-xx/xx, follow procedure [A] REP04-301. Otherwise if the Setup
Installer floppy has version 01-01-xx, follow procedure [B] REP04-305.

A. If Setup Installer version is 01-00-xx-xx/xx.

1. Powering up the SVP

2. Close Windows
® <Select [Exit Windows...]>

F't-o.gra-rrl_;dxz-ﬁ.r:!

. N . New... hd
Select [Exit Windows...] from [File] (DR). ik e »
Move... F7
Copy.. F8
Delete Del
Properties.... Alt+Enter
Bua...

@ <Check ending of [Windows]>
Select [OK] (CL) in response to “This will end your
Windows session.”.

9 This will end pour Windows session.

o] [(oomeel

3. Installation of Micro-program

@ Insert the floppy disk of (1/14) into the FDD.

@ Input “a:\setcopy.bat” in “DOS prompt’, and press the [Enter] key.

® When the message “SET FD NO. (2/14)” is displayed, insert the floppy disk of (2/14) into the FDD and press
the [Enter] Key.
Copy the remaining floppy disks ((3/14) ~ (13/14)) in succession in response to the displayed messages.
When the message “SET FD NO. (14/14)” is displayed, remove the floppy disk of (13/14) from FDD.
Press the [Ctr]] and [C] keys simultaneously.
Input “Y” keys in response to “Terminate batch job (Y/N)?”, press the [Enter] key.

06 06

4. Reboot the PC.
® Reboot the PC by [Alt], [Ctrl], and [Del] keys simultaneously.

5. Installation of Program group and item.
® Insert the floppy disk of (1/14) into the FDD.
@ Select [File] and [Run] in Program Manager.
O Input “a:\setup.exe” on command line, and select [OK]. The ‘SVP’ and the ‘Startup’ groups will be made.
@ Select ‘Startup’ and press [Ctrl] key and [F4] key simultaneously.
® Remove the floppy disk of (1/14) from FDD.
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5-1 Reboot the PC
@ <Select [EX]I Windows...]> i Options  Windaw Help
Select [Exit Windows...] from [File] (DR). s - B
Delete Del

(| Eroperties... Ah+Enter

{| Bun..
|W

I

@ <Check ending of [Windows]>
Select [OK] (CL) in response to “This will end your
Windows session.”

O This will end your Windows session.

| ok | | cancel |

® <Reboot the PC>
Reboot the PC by [Alt], [Ctrl] and [Del] keys simultaneously.

Set IP address of PC.

© <Open s> B > @n
Select [Install] Icon from ‘SVP’ (DC). !

Information Status Diag
Fdcopy = Dnline

@ <Check copyrights>
Select [OK] (CL).

nstall

G) <SCICCI [MOdlfy]> File lnsul Mode
Select [Modify] from [Mode] (DR).

Inztall

@ <Select [Set IP Address...]>
Select [Set IP Address...] from [Install] (DR).

Flie BUTSEUN Mgde
Define Configuration and Install...
Reter Configuration...

System Tuning...

Logical Device Formst..

Manual Dump...
MP Install..
System Jime...
Set IP Address...
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® <Input “Serial No.”>

Set IP Address
Select [Specify] (CL), and then select [OK] (CL)

after input “Serial No.”. N @

G Restore Address

® <Check PC reboot> = Set IP Address

0 Please reboot PC.

Select [OK] (CL).

@ <Select [Exit]>
Select [Exit] from [File] (DR).

® <Check endingof (nsall>

Select [OK] (CL) in response to “This will end the Install.”.
@ This will end the Install.

0K Cancel

7. Copy the Configuration.
@ Insert the floppy disk of (14/14) into the FDD.
@ Select [Run] from File].
® Input “a:\all_conf.bat” on command line, and select [OK].
@ Remove the floppy disk of (14/14) from the FDD.

8. Close Windows
® <S8elect [Exit Windows...]>
Select [Exit Windows...] from [File] (DR).

Program i;lanager“

[l

Alt+Enter

@ <Check ending of [Windows}> = Exit Windows

0 This will end your Windows session.

Select [OK] (CL) in response to “This will end your
Windows session.”.

OK I | Cancel |

Copyright ©1995,1997, Hitachi, Ltd.

| REV.7 ||Nov.1995|Mar.1996lMay.1996| Jul.1996 IMar.1997|Nov.1997' REPO4-3O3




K6600890-

9. Reboot the PC.

@ Reboot the PC by [Alt], [Ctrl], and [Del] keys simultaneously.

10. Load the Configuration from the SM to the PC’s HDD.
® <Open [Online]>
Select [Online] from ‘SVP’ (DC).

@ <Check copyrights>
Select [OK] (CL).

@ <“Reading the Subsystem Configuration”>
“Reading the subsystem configuration data...” is
displayed.

® <Select [Exit]>
Select [Exit] from [File] (DR).

® <Check ending of [Online]>
Select [OK] (CL) in response to “This will end the
Online Maintenance.”.

information Status Diag
Fdcopy Install

Copyright [C) 1994,1995,Hitachi,Ltd.

oK

Online Maintenance

Reading the subsystem configuration data...

0x
i

Mammnsace_Made

@ This will end the Online Maintenance.

oK Cancel
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11. Check SVP-DKC Connection.
® <Open [Status]>

Select [Status] Icon from ‘SVP’ (DR) -
E=m

Information Diag
Fdcopy Instalt Onfine

@ Check “Connection error occurred SVP-DKC.” is not displayed.

General Status Display -

® <Select [Exit]>
Select [Exit] from [File] (DR).

@ <Check ending of [Status}>
Select [OK] (CL) in response to “This will end the Status.”.

Cancel

Copyright ©1996,1997, Hitachi, Ltd.
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B. If Setup Installer version is 01-01-xx-xx/xx or after.

Note) If Setup Installer version is 01-02-xx-xx/xx or after, the floppy disk number is (1/19) ~ (19/19).

1. Powering up the SVP

1-1 Set LAN Card Driver
* Windows3.1
Goto 2.

* Windows95

If SVP displays a message, “This DHCP client was unable to
obtain an IP network address from a DHCP server. Do you
want to see future DHCP messages?”, select [Yes] (CL) and go
to ®@. If SVP does not display the message, go to 2.

® <Open “My Computer”>
Select “My Computer” (DC).

@ <Open “Control Panel”>
Select “Control Panel” from “My Computer” (DC).

@ <Open “Network™>
Select “Network” from “ Control Panel” (DC).

This DHCP client was unable o obtain an [P network address from a
DHCP server. Do you want to see fulure DHCP messages?

(CXer J| Mo |

L] 7% 0mm

B My Computer - O] X]

Fie Edt View Help

3% Floppy (A:) (C) D

Printers Dial-Up
Networking

1 objecl(s) selected

B9 Cuntiul Pal |- =] x]
Fio Edt Yew Hep

T % = ¢ 4 @7

Add N AddR Date/T
A -~ omove Compag Compag (]

A 8

Fonts Irtesmnt

[
PEoumd
Shor -
O =
Mad and Fax  Mcrosolt Med
ostafice

L4 =
g 5 % 5 5% @
Mot [ ]
kd L

Passwonds PC Card

FOMOA)
H -
.t."d ' ZiJJ
Prrcans Regona Sysiem —
Setangs =
Configuses network herdware and sofrware.

Copyright ©1996,1997, Hitachi, Ltd.

| REv.4 [May.1096] ut1996 | Dec.1996 | Mar.1997 [ sun. 1907 | ' REP04-306




K6600890-

@ <Delete “Network components™> Network HE]
Select one of the “Network components” from Configuation |
Configuration” (CL), and select [Remove] ((?L)' The folowing netwerk components are installed:
Delete other all “Network components” for this TP ne o CE-Ips CrediCatd Etbwete et daniet [7PS Diiver)
operation. B3 Xcom CE-lips CreditCard Ethemst Adapter (XPS Driver)
g TCPAP -> Xzcom CE 4lps CreditCard E themst Adapter (XPS [
§~ TCPAP -> Xircom CE 4ips CreditCard E themat Adapter KPS L
Add...
Primary Network Logon:
[Wndows Logon ;[
Description
A network adapter is 2 hardware devics that physically
connects your computer o a network.
ok | cancel |
® <Close “Network™> Network [ 7] X]
Select [OK] from “Configuration” of “Network™ Configuration ]
(CL).

The following network components are installedt

add. | | |

Primary Network Logon:
|Wndows Logon ﬂ

Description

® <Reboot the SVP>

Select [Yes] (CL) in response to “You must restart ? :?:;mt restart your computer before the new settings wil take
your computer before the new settings will take
effect.

Do you want to restart your computer now?”,

Do you want to restart your computer now?

Copyright ©1996,1997, Hitachi, Ltd.
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® <Check setting LAN Card Driver>

Select [No] (CL) in response to “To finish setting @) Tofinish setting up your new hardware, you must restar your
up your new hardware, you must restart your a'

-
computer. Do you want to restart your computer now?

Do you want to restart your computer now?”. Yes |

® <Open “Network™> Tie £ Yo Heb
Select “Network” from “Control Panel” (DC). —_ v 1t2 =]
®) 5 K 3 L 4
Accessbity AddNew Add/Romove Compag Compaq Data/Tme
Options Hardware Programs Diagnosics It
dibon

% 4 & = B 3
[

Display Keyboard  Mad andFax  Microsolt Mal
Pottolfce

225

BEEN  Paowards PCCad

POMCIA)
¥y 2 ® £ =
Prrtess Regional

Power Sounds Systom —

Configures neiwork hardware and software. i

® <Delete “Network components™> Network K
Select all “Network components” from Configuation | identiication | Access Control |

“Configuration” of “Network” except the following
necessary “Network components™, and select

The foliowing netwotk components are instaled
B Chent for Mictosaft Nelworks

[Remove] (CL).
Necessary “Network components™ :
Xircom CE-IIps Credit Card Ethernet Adapter [XPS Driver] d~ NetBEUI
Add.. Properies |
Primary Network Logon:
| Chiert for Microsolt Networks ~|

Fle and Pint Shasig.. |

Descnption

The Chent for Microsoft Networks enables you to connect to
other Microsolft Windows computers and servers and use the
files and printers shared on them.

0K Cancel
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® <Add “Network components”>

Select [Add...] from “Configuration” of “Network”

(CL).

—

9 <Add “Protocol”>
Select “Protocol” from “Select Network

Components Type” (CL), and select [Add...] (CL).

2 <Select “Protocol™>
Select “Microsoft” from “Manufacturers” (CL),
and “TCP/IP” from “Network Protocols” (CL),
and select [OK] (CL).

Nelwork KHE
Configuraion |
The following network components are instaled:
Xacom CE-lIps CredtCard Ethemst Adapter [XPS Driver)
Prmary Network Logon:
IWndows Logon _'_—l
Description
oK | Concel |
Select Nelwork Component Type E3

Chck the type of network companent you want to nstal:

Protocal is 2 language’ a computer uses. Computers
must use the same protocol to communicate.

Select Network Protocol | x|

- Click the Network Protocol that you wart to intal, then cick OK. If you have
N3 an nstallation disk for this device, cick Have Disk.

Network Protocoks:

& IPX/SPX-compatibie Protocol
Mierosoft 32-bi DLC

% Microsoft DLC

NetBEUI

Copyright ©1996,1997, Hitachi, Ltd.
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@ <Set “TCP/IP™> Network HE
Select “TCP/IP” from “Configuration” (CL), and Corfiguraton |
select [Properties] (CL).

The foliowing network componeris are instaled:
Xircom CE-fips CreditCard Ethemet Adapter (XPS Driver)

Add. | Bemowe
Prmary Network Logon:
IWndows Logon Ll
Descrption
TCP/IP is the protocol you use to connect to the internet and
wide-area networks.
0K | Concel |
@ <Select “IP Address™> TCP/IP Praperties HE
Select “Specify an IP Address” from “IP Address” Bndngs | Advanced |  DNS Configwation |
(CL), and set “126.0.0.32” for “IP Address”, and Gateway |  WINS Configuiation IP Address
set “255.0.0.0” for “Subnet Mask”, and select [OK] AnlP address can be automaticall assigned to this computer,
(CL) If your network does not automaticaly assign IP addiesses, ask
: your network administrator for an address, and then type it in
the space below.

¢ Dbtain an IP address automatically
& Specily an IP address:

IPAddess  [126. 0 . 0 .32 | |

SubnetMask: [255. 0 . 0 . 0 |

Copyright ©1995,1996,1997, Hitachi, Ltd.
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€ <Close “Network™>
Select [OK] from “Configuration” of “Network”
(CL).

6 <Check reboot SVP>
Select [No] (CL) in response to “You must restart
your computer before the new settings will take
effect.
Do you want to restart your computer now?”.

42 <Close “Control Panel”>
Select [Close] from [File] (DR).

Network

(7] x]
The following netwotk components are instaled

Xarcom CE-lips CrecitCard Ethemet Adapter (XPS Driver)
TCPAP

e | | |

Primary Netwotk Logon:
[Windows Logon ~|

Descrption

System Settings Change *

You must restat your computer before the new settings will take
» effect.

Do you want to restart your computer now?

_ = |

Y Contiol Panel - 1O] x]
G Ect Vew Heb
gm — - -
v 4 B§
Croate Shorteut - i
Compaq Compagq Date/Time
Diagnosics Innght
o
L
7 I
(.

d MalandFax Microsoft Mal
Postoffice

AN N

Patswords PC Card

CRET
[

ukimedia
{POMOA)

“ o
¥ 24 ® £ =
Powes Prriten Regoral Sounds System —I

Settings ]
Clotes the wandow.
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9 <Close “My Computer™> B, My Computer - D] x|
Select [Close] from [File] (DR). Edit View Help

S

] Control Panel

Printers Dial-Up
Networking

Closes the window.

2. Close Windows
» Windows3.1
® <Select [Exit Windows...]>
Select [Exit Windows...] from [File] (DR).

Program Manager

QOptions Yindow Help

New... *
Open Enter
Move... F7
Copy... F8
Deiete Del
Properties... AR+Enter

Bun...

@ <Check ending of [Windows]>

Select [OK] (CL) in response to “This will end your
Windows session.”.

0 This will end your Windows session.

ok | | cancel |

* Windows95
® <Select [Shut Down]>
Select [Shut Down] from [Start] (DR).

Copyright 1997, Hitachi, Ltd.
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@ <Select “Restart the computer in MS-DOS mode™> |MEI
Select “Restart the computer in MS-DOS mode” from
Shut Down Windows, and select [OK] (CL) in @
response to “Are you sure you want to;”.

Ase you sure you want to

O Shut down the computer?
O Restait the computer?
{2 Restart the computer n M5-D0S mode?

I_Yes ||  No || Hep

3. Installation of Micro-program

® Insert the floppy disk of (1/14 or 1/19) into the FDD.

@ Input “a:\setcopy.bat” in ‘DOS prompt’, and press the [Enter] key.

@ When the message “SET FD NO. (2/14 or 2/19)” is displayed, insert the floppy disk of (2/14 or 2/19) into the
FDD and press the [Enter] Key.

® Copy the remaining floppy disks ((3/14 or 3/19) ~ (14/14 or 19/ 19)) in succession in response to the displayed
messages.

® When the message “SET FD NO. (1/14 or 1/19)” is displayed, insert the floppy disk of (1/14 or 1/19) into the
FDD and press the [Enter] key.

® Remove the floppy disk of (1/14 or 1/19) from FDD.

Copy the PC information to HD.

® Insert the floppy disk of (1/14 or 1/19) into the FDD.

@ Input “a:\pcconf.bat” in ‘DOS prompt’ and press the [Enter] key.

Q@ The message “"pcconf™ change START!!” is displayed, and the message “"pcconf” change END!!” after file
copy.

@ Press the [Enter] key, and remove the floppy disk of (1/14 or 1/19) from the FDD.

4-1 Copy the ARMADA PC information to HD

If the PC is ARMADA (COMPAQ-made) and Windows3.1.

® Input “c:\armada31.bat” in ‘DOS prompt’ and press the [Enter] key.

@ The message “"ARMADA31" change START!!” is displayed, and the message “"ARMADA31" change
END!!” after file copy.

@ Press the [Enter] key.

5.

Reboot the PC.
® Reboot the PC by [Alt], [Ctrl], and [Del] keys simultaneously.

Installation of Program group and item.

® Insert the floppy disk of (1/14 or 1/19) into the FDD.

@ Select [File] and [Run] in Program Manager.

@ Input “a:\setup.exe” on command line, and select [OK]. The ‘SVP’ and the ‘Startup’ groups will be made.
If the Task bar is displayed, go to ®. (Task bar : See the figure in subsection 10.1.2 (2) of SVP section.)

® Select ‘Startup’ and press [Ctrl] and [F4] keys simultaneously.

® Remove the floppy disk of (1/14 or 1/19) from FDD.

Copyright ®1997, Hitachi, Ltd.

| revo "Mar.1997l I ] [ I 7 REP04-310C




K6600890-
6-1 Reboot the PC

* Windows3.1
® <Select [Exit Windows...]>

Qptions  Window Help

Select [Exit Windows...] from [File] (DR). -~ u
Delete Del
Properties... Ah+Enter

@ <Check ending of [Windows]>

Select [OK] (CL) in response to “This will end your
Windows session.”

o This will end your Windows session.

[ ok ] [ cancel |

® <Reboot the PC>
Reboot the PC by [Alt], [Ctr]] and [Del] keys simultaneously.

» Windows95
® <Select [Shut Down]>
Select [Shut Down] from [Start] (DR).

s ] 35 35 35 20 S 05 My o e 39 x5

@ <Reboot the PC>

Select “Restart the computer” from Shut Down
h Are you sure you want tar
Windows, and select [OK] (CL) in response to Qg
" " Shut down the computer?
“Are you sure you want to:

@ Restart the computer?
€ Restait the computer in MS-DOS mode?

Copyright @1997, Hitachi, Ltd.
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7. Set IP address of PC.
® <Open [Install)>

Select [Install] Icon from ‘SVP’ (DC).

@ <Check copyrights>
Select {OK] (CL).

@ <Select [Modify]>
Select [Modify] from [Mode] (DR).

@ <Select [Set IP Address...]>

Select [Set IP Address...] from [Install] (DR).

® <Input “Serial No.”>

Select [Specify] (CL), and then select [OK] (CL)

after entering “Serial No.”.

® <Check PC reboot>
Select [OK] (CL).

@ <Select [Exit]>
Select [Exit] from [File] (DR).

— Install -]~

File [nstall QEITS
v View
Modity

Install

Flle BIGSENN Mode
Define Cenfiguration and Install..
Refer Configuration...

System Tuning...

Logical Device Format..

Manusl Demp..,
MP install..
System Jime...
Sel I Address...

Set IP Address

O Restore

== Set IP Address
0 Please reboot PC.

OK

(§11 8 |nstall Mpde
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Select [OK] (CL) in response to “This will end the Install.”.

8. Close Windows.
» Windows3.1

. . Proar M
® <Select [Exit Windows...]> T T —
. . New.. O
Select [Exit Windows...] from [File] (DR). s B -
Mowve._. F7
Copy... F8
Delete Del
PBroperties...  AR+Enter
Bun..

@ <Check ending of [Windows]>
Select [OK] (CL) in response to “This will end your
Windows session.”.

O This will end your Windows session.

» Windows95
@ <Select [Shut Down)>
Select [Shut Down] from [Start] (DR).

T [ T T [T I D - S T = SN

K6600880-
® <Check ending of [Install]>
|
I
|
I

@ <Select “Restart the computer™> |

Select “Restart the computer” from Shut Down
Windows, and select [OK] (CL) in response to “Are @
you sure you want to:”.Go to 10,

Are you sure you wart ta.
O Shut down the computer?

© Pestart the computerd
O Restart the computer in MS-DOS mode?

LY || Mo || Hep | |
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9. Reboot the PC.

@ Reboot the PC by {Alt], [Ctrl], and [Del] keys simultaneously.

10. Load the Configuration from the SM to the PC’s HDD.

® <Open [Online]>
Select [Online] from ‘SVP’ (DC).

@ <Check copyrights>
Select [OK]} (CL).

@ <“Reading the Subsystem Configuration™>
“Reading the subsystem configuration data...” is
displayed.

@ <Select [Exit]>
Select [Exit] from [File] (DR).

® <Check ending of [Online]>
Select [OK] (CL) in response to “This will end the
Online Maintenance.”.

BE___ v oo

Information Status Diag
Fdcopy Install

Copyright (C) 1984,1985, Hitachi,Ltd.

OK

Online Maintenance

Reading the subsystem configuration data...

02

Meirtcnence  Mgde

@ This will end the Online Maintenance.

0K

Cancel
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| REV.0 UMar.1997| ]

[ | | REP04-310G




K6600890-

11. Check SVP-DKC Connection.
® <Open [Status)>

Select [Status] Icon from ‘SVP’ (DR). -
(5t

Information Diag
Fdcopy Install Online

@ Check “Connection error occurred SVP-DKC.” is not displayed.

General Stalus Display -

® <Select [Exit]>
Select [Exit] from [File] (DR).

® <Check ending of [Status]>
Select [OK] (CL) in response to “This will end the Status.”.

Cancel

Copyright ©1997, Hitachi, Ltd.
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{10] LTM PCB (Terminator)

If message to varied off the concerned channel path(s) was displayed, go to 2.
Else, goto 1.

1. Select [OK] (CL) in response to the displayed

message after replacing. m

Go to {15]) (REP04-350). 0

The repiacement of LTM PCH is done. And the
OP panel is restored [only parallet channels).

2. Ifthe message is displayed as shown on the right, the

concerned channel paths are available, please vary the | = I R |

paths on-line. The replacement of LTM PCB is done.

Go to [15] (REP04-350). The concemed channel path(s] are available.
Please vary the pathis] on.
And the OP panel is restored [oniy paraliel

channels).

Copyright ©1996,1997, Hitachi, Ltd.
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[11] REMOVAL OF JUMPERS

L

<Remove jumpers>

Remove jumpers from PWRCTL PCBs (1 and 2) in
response to “Please detach "CE PANEL INH" jumper
plug. Then press OK.”.

After confirming that jumpers are detached, select [OK]
(CL).

“Reading the environment monitor...” is displayed.
Go to [13] (REP04-350).

If any jumper plug is not detached, go to 2.

- Please detach “CE PANEL INH" jumper plug.
Then press OK.

Reading the environment monitor...

2. <Check removal of jumpers>
The message “"CE PANEL INH" jurnper plug is not :m_
detached. Please detach it. Then press OK.” is “CE PANEL INH" jumper plug is not detached.
displayed. Detach jumper plugs and select [OK] (CL). Plessc detach It Then press OK.
“Reading the environment monior..” is iplyed. [ R
Go to [13 P04-350).
[13] RE ) Reading the environment monitor...
If any jumper is not detached, step 2 again.
If the same message is displayed twice, go to 3.
3. <error status>
Select [OK] (CL). B REPLACE
After checking jumper plug three times, the
® error status Is not changed. "PWRCTL PCB*
may have problem.
[ End of Replacement ]

Copyright ©1995,1997, Hitachi, Ltd.
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[12] SSVP/HUB

1. Confirm that the cables are connected correctly.
Turn on SSVP and select [OK] (CL).

After replacement SSVP, confirm the following
subjects.

The cables are connected correctly,

Turn "SSVP ENABLE" switch to "ENABLE."
Then press OK.

2. The message “Restoring DKC-SVP communication.
Wait...” is displayed.

Restoring DKC-SVYP
communication. Wait...

3. The message “SSVP microprogram download.” is

displaved. If the restore is successfully completed goto
next step.

If an error has occurred in restoring , the error message
is displayed.

If you select [OK] (CL) go back to step 2.

If you select [Cancel] (CL) go to step 5.

SSVP microprogram download.
(1116}

- SSVP Hardware Replace

DKC-SVP communication restore error has

occufred.
Confirm the cables are connected correctly.
Then press OK.

K6600890-
|
|

(o] [oone]
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4. The message “The replacement of SSVP has completed.”
is displayed.
Go to [15] (REP04-350).

if an error has occurred while downloading, an error
message is displayed.

If you select [OK] (CL) go back to step 3.

If you select [Cancel] (CL) go to step 5.

= SSVP Hardware Replace

O The replacement of SSVP has Eomplctcd.

- SSVP Hardware Replace

SSVP microprogram downioad has failed!

After confirming the RS-232C cable is connected
® correctly.

Turn “SSVP ENABLE" switch to "ENABLE."

Then press OK.

Lok ] [cancel]

5. Theerror message is displayed.

[ End of POST-PROCEDURE ]

— SSVP Hardware Replace

@ The replacement of SSVP has failed.

OK

Copyright ©1995,1997, Hitachi, Ltd.
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[13] ending check

1. <Check end of replacement™>

Select [OK] (CL) in response to “Replacement of the
"XXXXX" is done.”.

O Replacement of the "*System panel” is done.

2. <Confirm status>
* PWRCTL-1/2
Confirm the status displayed on ‘OTHERS’ window.
If “NORMAL,” go to [15] (REP04-350).
I “FAILED,” replace the target part again, or see TROUBLE SHOOTING SECTION.
[ End of POST-PROCEDURE ]

* Other P/K
Go to [15] (REP04-350).

[14] Replacement error

1. Theerror message “Replacement of the "X>OCKX"
failed.” is displayed as shown on the right.

@ Replacement of the "EPO SW" failed.

[ End of Replacement ]

OK

[15] SIM Complete
See SVP02-510.
Close ‘OTHERS’ window.
Close ‘Hardware Maintenance’ window.
Close ‘Maintenance Online’ window.

[ End of POST-PROCEDURE ]
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[16] System panel

1. Select [OK] (CL) in response to “REMOTE
MAINTENANCE SWITCH TEST: After turning
switch to ENABLE position, press OK.”.

- System panel replacement |

REMOTE MAINTENANCE SWITCH TEST :
After turning switch to ENABLE position, press

OK.

2. If an communication error has occurred, go to step 8.

If an error has occurred in the switch test, an error
message is displayed.

If you select [Yes] (CL), go back to step 1.

If you select [No} (CL), go to [14] (REP04-350).

= System panel replacement

Switch status is wrong.
Do you retry switch test?

Yes

No

3. Select [OK] (CL) in response to “REMOTE
MAINTENANCE SWITCH TEST: After turning
switch to DISABLE position, Press OK.”.

= System panel replacement

REMOTE MAINTENANCE SWITCH TEST :
O After turning switch to DISABLE pesition, press
OK.

4. 1f an communication error has occurred, go to step 8.

If an error has occurred in the switch test, an error
message is displayed.

If you select [Yes] (CL), go back to step 3.

If you select [No] (CL), go to [14] (REP04-350).

= System panel replacement

Switch status is wrong.
Do you retry switch test?

Yes

No
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= System panel replacement

RESTART SWITCH TEST ;
After turning switch, press OK.

5. Select [OK] (CL) in response to “RESTART SWITCH
TEST: After turning switch, press OK.”.

oK

6. If a communication error has occurred, go to step 8.
If an error has occurred in the switch test, an error
message is displayed.

If you select [Yes] (CL), go back step 5.
If you select [No] (CL), go to [14] (REP04-350).

= System panel replacement

Switch status is wrong.
Do you retry switch test?

Yes

No

7. If switch test is successfully completed, go to [13] (REP04-350).

8. Select [OK] (CL) in response to “SVP-SSVP
communication error has occurred.”.
Press [OK], go to [14] (REP04-350).

- System panel replacement

@ SVP-SSVP communication error has occurred.

Copyright ©1995.1996, Hitachi, Ltd.
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[POST-PROCEDURE 3]

— OUTLINE —

® Specify end of special part replacement.
@ Reinstall related parts.

® Start environment monitor.

@ SIM Complete
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[1] START OF POST-PROCEDURE

1

<Check special part replacement>
* ‘xxPSn’

When redundant power supply is not installed. ~—-- Go to [7] (REP04-401)

* ‘Breaker Box-1" -— Go to [3] (REP04-390)

Select [OK] (CL) in response to “Please replace the "X3OCKK" After replacement, press OK.”.

Valid “XXXXX" values are listed below.

« ‘FAN’ Go to [2] (REP04-380)
* ‘Battery’ —---——- Go to [2] (REP04-380)
* ‘TH’ -—=eeee— Go to [2] (REP04-380)

B e
o

Please replace the "'Fan assembly.” After
replacement. press OK.

[ ok ] [cancel]

Select [OK] (CL) in response to “Please switch "xxPSn" to "DISABLE," and replace it. After replacement, switch

it to "ENABLE" and press OK.”.

* ‘xxPSn’

When redundant power supply is installed.
——— Go to [2] (REP04-380)

O Please switch "MPS10" to “DISABLE."” and

replace it. After replacement. switch itto
“ENABLE" and press OK.

[ ok | [cancet|

Select [OK] (CL) in response to “Cannot replace target because the mate PSs are in failure. At first, please switch
“5VPSn, 5VPSx2” to “DISABLE,” and replace them. After replacement, switch them to “ENABLE” and press

OK.”.
« ‘5VPSn’

Go to [2] (REP04-380)

T S

Cannot replace target because the mate PSs
are in failure.

@ At first, please switch "SVPS10, 5VPS12" to
*DISABLE." and replace them. After
replacement, switch them to "ENABLE" and
press OK.

| oK | |cancel]

Select [OK] (CL) in response to “Turn off the breaker which supplies power source for Breaker Box-2. After that
please replace it. When replacement is completed, press OK.”.

* ‘Breaker Box-2’
When redundant power supply is installed. -- Go to [2]
(REP04-380)
Not installed. — Go to [4] (REP04-400)

Tum off the breaker which supplies power
o source for Breaker Box-2.

After that please replace it.
When replacement is completed, press OK.
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[2] FAN, PS, Battery, TH, Breaker Box-2
1. <Checking the environment monitor start processing>

“Processing to enable the environment check...” is
displayed.

Wait about 30 sec..

Processing to enable the environment
check...

2. <Checking environment monitor read>
“Reading configuration...” is displayed.

“Reading the environment monitor...” is displayed.

Reading configuration...

Reading the environment monitor. .

3. <Checking the end of replacement>
Select [OK] (CL) in response to “Replacement of the
"XOXXX" is done.”.

0 Repliacement of the "'MPS10" is done.

OK
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4. <Confirm status>
* FAN, PS, Battery, TH
Confirm the status displayed on ‘DKC Cluster-x” window.
If “NORMAL,” go to [5] (REP04-401).
IF “FAILED,” replace the target part again, or see TROUBLE SHOOTING SECTION.
[ End of POST-PROCEDURE ]

* Breaker Box-2
Go to [5] REP04-401).
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[3] Breaker Box-1

1. <Open ‘OTHERS’ window>
Open ‘OTHERS’ window.

(See PRE-PROCEDURE A (REP02-20) and PRE-PROCEDURE T3 [1]-1, 2 (REP02-560))

2 <selecting Cluster>
Select [Cluster] from ‘OTHERS’ (CL).

Parts bat h:]

(g Oracoms  OPwrcTL  MOMAL)

Cerosv Onoucoet O rwaciiz MomsAl]
OSpampoa O LT4 PRAT
O 0P ponai1 OLmeroean Chstar ——
Oorpaatz  Osve
© Detiat Bae O sswe

O s com =] | E=3

Parta stann Porta staten
MDMMAL}

DEL-L2 DI (17 OKL-At =] FDEU-A?—
ORU L4 1DKL LIRS pec . []blul!m. l’lnxu-ﬂzm
Pon vt

3. <selecting recover>
® When first message of replacement is “This operation
will block Cache Box-1. Do you want to replace the
"Breaker Box-17"", select [Cache Box-1] from
‘CLUSTER’ (CL) and select [Recover] (CL).

@ Otherwise, select [Cluster-1] from ‘CLUSTER’ (CL)
and select [Recover] (CL).

Pats fst
O M-BUs ® Chster-1. O Cache Box-1
OFBUSH O Custer2 O Cache Bon-2

QO FaUSL
' Block II Recover I

Cloze

4. <Beginning Restore>
Select [Yes] (CL) in response to “Do you want to
recover XXXXX7".
XXXXX represents one of the part names selected in step
3.
If XXXXX is blockade. Goto 6
If XXXXX is normal. Goto 7
IFXXXXX is fail. Goto 5

9 Do you want to recover Cluster-1 ?

No
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5.

<Confirm blocking limit>
When recovering Cluster-1,

» When only serial or paraliel channels, or they are mixed.

Select [OK] (CL) in response to “This operation will
block Cluster-1 before recovery. Please confirm you
have already varied off the concerned channel path(s).
Do you want to continue?”.

e When SCSI channels and other kinds are mixed.
Select [OK] (CL) in response to “This operation will
block Cluster-1 before recovery. Please confirm you
have already varied off the concerned channel path(s).
Please confirm you have already shutdown concerned
connecting SCSI host(s) or switched to the alternate
SCSI channel path(s). Do you want to continue?”.

e When only SCSI channels are installed.

Select [OK] (CL) in response to “This operation will
block Cluster-1 before recovery. Please confirm you
have already shutdown concerned connecting SCSI
host(s) or switched to the alternate SCSI channel path(s).
Do you want to continue?”.

When recovering Cache Box-1, select [OK] (CL) in
response to “This operation will block Cache Box-1
before recovery. Do you want to continue?”,

B ones )
- This operation will block Cluster-1 before

recovery.

9 Pieage confirm you have already varied off the

concerned channel path(s).
Do you want to continue 7

[SPC2150))

This operation will biock Cluster-1 before
recovery.

Picase confim you have already varied off the
concerned channel path(s).

Please confirm you have already shutdown
concerned connecting SCS| host{s) or switched
to the alternate SCS! channel pathis).

Do you want to continue ?

@

[SPC21511]

This operation will block Cluster-1 before
recovery.

Please confirm you have slready shutdown
concemed connecting SCS! host(s) or switched
to the altemate SCSI channe! path(s).

Do you want to continue ?

- Ohes ]
This operation will block Cache Box-1 before
recovery. Do you want to continue ?

Lok ] [cancel]
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Reading the environment monitor...

6. “Reading the environment monitor...” is displayed.

7. <end of Restore>
When recovering Cluster-1,
e When only serial or parallel channels, or they are mixed.
Select [OK] (CL) in respons to “The restore has B ohes
finished. Cluster is enabled. The concerned channel The restore has finished. Cluster is enabled.

path(s) are available. Please vary the path(s) on.”. The concerned channel path(s) are avallable.
Please vary the path(s) on.

e When SCSI channels and other kinds are mixed.

Select [OK] (CL) in response to“The restore has [ S |

finished. Cluster is enabled. The concerned channel [SPC2154]

path(s) and SCSI channel path(s) are available. Please
th th ” The restore has finished. Cluster Is enabled.
vary the path(s) on.”. The concerned channel path(s) and SCSI

channel path{s) are available.
Pieasc vary the path(s) on.

e When only SCSI channels are installed.

Select [OK] (CL) in response to“The restore has [ T ]

finished. Cluster is enabled. The concerned SCSI [SPC2155]
channel path(s) are available.”. 0

The restore has finished. Cluster is enabied.
The concerned SCSI channel path(s) are
available.

0K|

When recovering Cache Box-1, select [OK] (CL) in B othes |

response to “The restore has finished. Cache Box is
enabled.”.

Go to [5] (REP04-401).

o The restore has finished. Cache Box is enabled.
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[4] Breaker Box-2

1. “Reading the environment monitor...” is displayed.

OTHERS

Reading the environment monitor...

<checking end of replacement>

@ When first message of replacement is “This operation
will block Cache Box-2. Do you want to replace the
"Breaker Box-2"", select [OK] (CL) in response to
“The replacement of Breaker Box-2 has finished and
Cache Box is enabled.”.

@ Otherwise

The replacement of Breaker Box-2 has finished
and Cache Box is enabied.

o When only serial or parallel channels, or they are mixed.

Select [OK] (CL) in response to “The replacement of
Breaker Box-2 has finished and Cluster is enabled.
The concerned channel] path(s) are available. Please
vary the path(s) on.”.

e When SCSI channels and other kinds are mixed.
Select [OK] (CL) in response to “The replacement of
Breaker Box-2 has finished and Cluster is enabled.
The concerned channel path(s) and SCSI channel
path(s) are available. Please vary the path(s) on.”.

o When only SCSI channels are installed.
Select [OK] (CL) in response to “The replacement of
Breaker Box-2 has finished and Cluster is enabled.
The concerned SCSI channel path(s) are available.”.

Go to [5] (REP04-401).

|

The replacement of Breaker Box-2 has finished
and Cluster is enabled.

The concermned channel path(s] are availabie.
Please vary the path(s) on.

o

%,

[SPC2152]]

The replacement of Bresker Box-2 has finished
and Cluster is enabled.

The concemed channe! path{s] and SCSI
channel path(s] are available.

Please vary the path{s) on.

T R
[SPC21531)
1)

The replacement of Breaker Box-2 has finished
and Cluster is enabled.
The concemed SCSI channe! path(s] are

avaliable.
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[S] Confirm Cluster and Cache Box
* PS, Breaker Box
If Cluster or Cache Box is blocked, recover it.
See SVP02-850 or SVP02-970.
Go to [6] REP04-401).
* FAN, Battery, TH
Go to [6] (REP04-401).

{6] SIM Complete
See SVP02-510.
Close ‘DKC Cluster-X’ window.
Close ‘OTHERS’ window.
Close ‘Hardware Maintenance’ window.
Close ‘Maintenance Online’ window.

[ End of POST-PROCEDURE ]

[7] PS

1. <Recover Cluster or Cache Box>
« 5VPS, 3VPS, MPS
Recover cluster that include target PS.
See SVP02-850.
«5VPSC, 3VPSC
Recover Cache Box that include target PS.
See SVP02-970.
Go to [5] (REP04-401).
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[POST-PROCEDURE t4]

— OUTLINE —

® Specify end of special part replacement.
@ Reinstall related parts.

® Start environment monitor.

@ DKU Path Inline Test

® SIM Complete
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[1] Start of POST-PROCEDURE

1. <Making part replacement check>
* FAN
Select [OK] (CL) in response to “Please replace the "X3OCXX" After replacement, press OK.”

Valid “X3OXXX values are listed below.

‘FAN’ e~eeeeee— Go to0 [2]-2 (REP04-430)
Please replace the *"Fan assembly." After

replacement, press OK.

| oK J l Canceﬂ
. ws_n, DKM‘H —_—
Select [OK] (CL) in response to “Please switch "XXXXX" to "DISABLE," and replace it. After replacement,
switch it to "ENABLE" and press OK.”.
‘MPS-n’ Go to [2]-2 (REP04-430) :_E_W
‘DKUMN-R2n’, ‘DKUMN-L2n’ 0 Please switch "MPS-R100" to "DISABLE." and

_ replace it. After replacement, switch it to
Go to [2]-2 (REP04-430) "ENABLE" and press OK.
‘DKUMN-R1n’, ‘DKUMN-L1n’
Go to [2] (REP04-430) [ ok | |cancet]

* AC BOX-n
‘AC BOX-R10° — Power on SVP and go to [3] (REP04-450)

Select [OK] (CL) in response 1o “Turn off the breaker | LR |

which supplies power source for AC BOX-XXX. After Tum off the breaker which supplies power

that please replace it. When replacement is completed, source for AC BOX-R11.
After that please replace it.

press OK.”. When replacement is completed, press OK.
‘AC BOX-R1Y’
When redundant power supply is installed

-~ Go to [2]-2 (REP04-430) e —

not installed - Go to [4] (REP04-460)
Other ‘AC BOX-n’ -~ Go to [5] (REP04-470)
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[2] DKUMN, FAN. MPS

1. <Enabling DKUMN>
When DKUMN-XXX (listed below) is installed, this
message is displaved.
Enable DKUMN in response to “Please switch
"DKUMN-XXX" to "ENABLE." Then press OK.”.
After confirming DKUMN-XXX is enabled, select [OK]
(CL).
DKUMN-XXX:

’ Please switch "DKUMN-R2F" to “"ENABLE."
Then press OK.

* For DKUMN-RIF: XXX=R2F (“DKUMN-R2F"), Switch DKUMN-R2F to ENABLE.
* For DKUMN-RIR: XXX=R2R (“DKUMN-R2R"), Switch DKUMN-R2R to ENABLE.
* For DKUMN-LI1F: XXX=L2F (“DKUMN-L2F"), Switch DKUMN-L2F to ENABLE.

* For DKUMN-LIR: XXX=L2R (“DKUMN-L2R"), Switch DKUMN-L2R to ENABLE.

2. <Checking environment monitor start processing>
“Processing to enable the environment check...” is
displayed.

Wait about 30 sec..

OTHERS

Proceszing to enable the environment
check...

3. <Check environment monitor read>
“Reading configuration...” is displaved.

“Reading the environment monitor...” is displayed.

Reading configuration...

- OTHERS

Reading the environment monitor...
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4. <Checking end of replacement>

Select [OK] (CL) in response to “Replacement of the |~ [ L -

"XXXXX" is done.”.

O Replacement of the "MPS-R100" is done.

5. <Confirm status>
Confirm the status displayed in ‘DKU-xx (xxx-xxx)’ window.
If “NORMAL,” go to [7] (REP04-480).
If “FAILED,” replace the target part again, or TROUBLE SHOOTING SECTION.

[ End of POST-PROCEDURE ]
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[3] AC BOX-R10

<Open ‘OTHERS’ window>
Open ‘OTHERS’ window.
(See PRE-PROCEDURE A (REP02-20) and PRE-PROCEDURE T4 [1}-1, 2 (REP02-660))

<Select Cluster>
Select [Cluster] from ‘OTHERS’ (CL).

[Pt S

Mama P Wams [ Ty E
B Oracom  OAwACTLY  MORMALY
Otrosw Onroucom OPwRCTLZ PORAL)
O Syoum panad O LTH PEBALC
CoPpwmit OLTHrPmED FSp—
Oorpemiz  Osve
© Dutat Bee Q ssve
O s conme =ny
[ORULZ=——= rORU-LT orC— [OKU-RT —} [DKU-R2—
1ORU L1 | | peruu T exe ] | lozuaig ]| | iokunas
Pot s Pow s Puta mons Pam senn Para satnm
1 [- = MNORMAL)
MORMAL)
Owean-2
PioAMAL)

<selecting recover>

® When first message of replacement is “This operation I = I

will block Cache Box-1. Do you want to replace the Parts st A (ge= |
"AC BOX-R10?"”, select [Cache Box-1] from OmBUs  @ThusterT O Cache Box-1

‘CLUSTER'’ (CL) and select [Recover] (CL). g :ﬂ:’: O Guster:z - O Cache Box2

[ Block I Recover

O Otherwise, select [Cluster-1] from ‘CLUSTER’ (CL)
and select [Recover] (CL).

<Beginning Restore>

Select [Yes] (CL) in response to “Do you want to
recover XXXXX7”,

XXXXX represents one of the part names selected in
step 3.

If XXXXX is blockade. Go to 6

HXXXXX is normal. Goto7

If an error occurs, go to 8

If XXXXX is fail. Goto 5

Q Do you want to recover Cluster-1 ?

Yes No

Copyright ©1995,1997, Hitachi, Ltd.

| Rev.11 [ec.1995|mar.1996 ] apr.1996 | sut 1996 |Dec. 1996 Jun 1997 REP04-450




K6600890-

5.

<Confirm blocking limit>
When recovering Cluster-1,

e When only serial or parallel channels, or they are mixed.

Select [OK] (CL) in response to “This operation will
block Cluster-1 before recovery. Please confirm you
have already varied off the concerned channel path(s).
Do you want to continue?”.

o When SCSI channels and other kinds are mixed.
Select [OK] (CL) in response to “This operation will
block Cluster-1 before recovery. Please confirm you .
have already varied off the concerned channel path(s).
Please confirm you have already shutdown concerned
connecting SCSI host(s) or switched to the alternate
SCSI channel path(s). Do you want to continue?”.

e When only SCSI channels are installed.

Select [OK] (CL) in response to “This operation will
block Cluster-1 before recovery. Please confirm you
have already shutdown concerned connecting SCSI
host(s) or switched to the alternate SCSI channel pathg(s).
Do you want to continue?”.

When recovering Cache Box-1, select [OK] (CL) in
response to “This operation will block Cache Box-1
before recovery. Do you want to continue?”.

. This operation will black Cluster-1 before
recovery.
0 Piease confirm you have aiready varied off the

concerned channel path{s].
Do you want to continue ?

B othes
[SPC21501)

This operation will block Cluster-1 before
recovery.

Please confirm you have already varied off the
concerned channel path(s).

Please confimn you have already shutdown
concerned connecting SCS! host{s] or switched
to the alternate SCSI channe! path(s].

Do you want to continue ?

Lok _| [Cancet]

2]

[SPC2151])

This operation will block Cluster-1 before
recovery.

Please confirm you have already shutdown
concemed connecting SCS! host{s) or switched
to the alternate SCSI channe! path(s).

Do you want to continue ?

| ox | [canceil

This operation will biack Cache Bax-1 before
recovery. Do you want to continue ?

| ok | [Cancer)
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Reading the environment monitor. =

6. “Reading the environment monitor...” is displayed.

7. <End of Restore>
When recovering Cluster-1,
e When only serial or parallel channels, or they are mixed.
Select [OK] (CL) in response to “The restore has B Othes ||
finished. Cluster is enabled. The concerned channel The restore has finished. Cluster is enabled.

path(s) are available. Please vary the path(s) on.”. The concemed channel path(s) are availabie.
Please vary the path(s) on.

o When SCSI channels and other kinds are mixed.

Select [OK] (CL) in response to “The restore has B Otes ||

finished. Cluster is enabled. The concerned channel [SPC21541]
path(s) and SCSI channel path(s) are available. Please

' the path » The restore has finished. Cluster is enabled.
vary the path(s) on.”. The concerned channel path(s) and SCSI
channel path{s) are available.

- Please vary the path|s] on.

e When only SCSI channels are installed.

Select [OK] (CL) in response to “The restor has 5 o= N

finished. Cluster is enabled. The concermed SCSI [SPC21551]
channel path(s) are available.”. o

The restore has finished. Cluster is enabled.
The concerned SCSI channel path(s) are
available.

When recovering Cache Box-1, select [OK] (CL) in
response to “The restore has finished. Cache Box is
enabled.”.

Go to [7] (REP04-480).
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8. <Restore error>
Select [OK] in response to “The restore has failed.”.

[ End of POST-PROCEDURE ]
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[4] AC BOX-R11

1. “Reading the environment monitor...” is displayed.

Reading the environment monitor...

2. <Endof replacement>
@ When first message of replacement is “This operation
will block Cache Box-2. Do you want to replace the
"AC BOX-R11?7", select [OK] (CL) in response to
“The replacement of AC BOX-R11 has finished and
Cache Box is enabled.”.

@ Otherwise

The replacement of AC BOX-R11 has finished
and Cache Box is enabled.

i0K|

e When only serial or parallel channels, or they are mixed.

Select [OK] (CL) in response to “The replacement of
AC BOX-R11 has finished and Cluster is enabled.
The concerned channel path(s) are available. Please
vary the path(s) on.”.

e When SCSI channels and other kinds are mixed.
Select {OK] (CL) in response to “The replacement of
AC BOX-R11 has finished and Cluster is enabled.
The concerned channel path(s) and SCSI channel
path(s) are available. Please vary the path(s) on.”.

e When only SCSI channels are installed.
Select [OK] (CL) in response to “The replacement of
AC BOX-R11 has finished and Cluster is enabled.
The concerned SCSI channel path(s) are available.”.

If no error happens, Go to {7] (REP04-480).
If an error occurs, Go to [6] (REP04-480),

— |

The replacement of AC BOX-R11 has finished
0 and Cluster is enabled.

The concerned channel pathfs) are available.
Please very the path(s] on.

oK

— I |
[SPC2152])
i

The replacement of AC BOX-R11 has finished
and Cluster is enabled.

The concerned channel path{s) and SCSI
channel path(s) are avallable.

Plcase vary the path(s) on.

IOK!

[SPC2153I)
The replacement of AC BOX-R11 has finished
and Cluster is enabled.

The concerned SCS! channel path(s) are
svsilable.

oK!

Copyright ®1995,1997, Hitachi, Ltd.

l REV.7 HJun.1995 |Nov.1995|~hr.1996| Jul.1996 ]Dec1996[ Jun.1997|

REP04-460




K6600850-

[5] ACBOX-n

1. <End of replacement>

Select [OK] (CL) in response to “The replacement of

ACBOX- n bas finished.”. o Th I t of AC BOX-L10 has finished
If no error happens, go to [7] (REP04-480). ¢ replacement o as fmshed.
If an error occurs, go to [6 P04-480).
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[6] Error

1. <Replacement error>

Select [OK] (CL) in response to “The replacement has
failed.”.

0 The replacement has failed.

[ End of POST-PROCEDURE ]

OK

[7] DKU Path Inline Test and confirm Cluster and Cache Box
* DKUMN-n
Execute DKU Path Inline Test for all DK As.
See DIAG04-190

* MPS-n, AC BOX-n
If Cluster or Cache Box is blocked, recover it.
See SVP02-850 or SVP02-970.
Go to [8] (REP04-480).

« FAN
Go to [8] (REP04-480).

(8] SIM Complete
See SVP02-510.
Close ‘DKU-xx (xxx)’ window.
Close ‘OTHERS’ window.
Close ‘Hardware Maintenance’ window.
Close ‘Maintenance Online’ window.

[ End of POST-PROCEDURE ]
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